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 A	 Standard Normal Distribution

Numerical entries represent the probability that a standard normal  
random variable is between -∞ and z, where z x

�
�µ
σ

.

 z  0.09 0.08 0.07 0.06 0.05 0.04 0.03 0.02 0.01 0.00

-3.4 0.0002 0.0003 0.0003 0.0003 0.0003 0.0003 0.0003 0.0003 0.0003 0.0003

-3.3 0.0003 0.0004 0.0004 0.0004 0.0004 0.0004 0.0004 0.0005 0.0005 0.0005

-3.2 0.0005 0.0005 0.0005 0.0006 0.0006 0.0006 0.0006 0.0006 0.0007 0.0007

-3.1 0.0007 0.0007 0.0008 0.0008 0.0008 0.0008 0.0009 0.0009 0.0009 0.0010

-3.0 0.0010 0.0010 0.0011 0.0011 0.0011 0.0012 0.0012 0.0013 0.0013 0.0013

-2.9 0.0014 0.0014 0.0015 0.0015 0.0016 0.0016 0.0017 0.0018 0.0018 0.0019

-2.8 0.0019 0.0020 0.0021 0.0021 0.0022 0.0023 0.0023 0.0024 0.0025 0.0026

-2.7 0.0026 0.0027 0.0028 0.0029 0.0030 0.0031 0.0032 0.0033 0.0034 0.0035

-2.6 0.0036 0.0037 0.0038 0.0039 0.0040 0.0041 0.0043 0.0044 0.0045 0.0047

-2.5 0.0048 0.0049 0.0051 0.0052 0.0054 0.0055 0.0057 0.0059 0.0060 0.0062

-2.4 0.0064 0.0066 0.0068 0.0069 0.0071 0.0073 0.0075 0.0078 0.0080 0.0082

-2.3 0.0084 0.0087 0.0089 0.0091 0.0094 0.0096 0.0099 0.0102 0.0104 0.0107

-2.2 0.0110 0.0113 0.0116 0.0119 0.0122 0.0125 0.0129 0.0132 0.0136 0.0139

-2.1 0.0143 0.0146 0.0150 0.0154 0.0158 0.0162 0.0166 0.0170 0.0174 0.0179

-2.0 0.0183 0.0188 0.0192 0.0197 0.0202 0.0207 0.0212 0.0217 0.0222 0.0228

-1.9 0.0233 0.0239 0.0244 0.0250 0.0256 0.0262 0.0268 0.0274 0.0281 0.0287

-1.8 0.0294 0.0301 0.0307 0.0314 0.0322 0.0329 0.0336 0.0344 0.0351 0.0359

-1.7 0.0367 0.0375 0.0384 0.0392 0.0401 0.0409 0.0418 0.0427 0.0436 0.0446

-1.6 0.0455 0.0465 0.0475 0.0485 0.0495 0.0505 0.0516 0.0526 0.0537 0.0548

-1.5 0.0559 0.0571 0.0582 0.0594 0.0606 0.0618 0.0630 0.0643 0.0655 0.0668

-1.4 0.0681 0.0694 0.0708 0.0721 0.0735 0.0749 0.0764 0.0778 0.0793 0.0808

-1.3 0.0823 0.0838 0.0853 0.0869 0.0885 0.0901 0.0918 0.0934 0.0951 0.0968

-1.2 0.0985 0.1003 0.1020 0.1038 0.1056 0.1075 0.1093 0.1112 0.1131 0.1151

-1.1 0.1170 0.1190 0.1210 0.1230 0.1251 0.1271 0.1292 0.1314 0.1335 0.1357

-1.0 0.1379 0.1401 0.1423 0.1446 0.1469 0.1492 0.1515 0.1539 0.1562 0.1587

-0.9 0.1611 0.1635 0.1660 0.1685 0.1711 0.1736 0.1762 0.1788 0.1814 0.1841

-0.8 0.1867 0.1894 0.1922 0.1949 0.1977 0.2005 0.2033 0.2061 0.2090 0.2119

-0.7 0.2148 0.2177 0.2206 0.2236 0.2266 0.2296 0.2327 0.2358 0.2389 0.2420

-0.6 0.2451 0.2483 0.2514 0.2546 0.2578 0.2611 0.2643 0.2676 0.2709 0.2743

-0.5 0.2776 0.2810 0.2843 0.2877 0.2912 0.2946 0.2981 0.3015 0.3050 0.3085

-0.4 0.3121 0.3156 0.3192 0.3228 0.3264 0.3300 0.3336 0.3372 0.3409 0.3446

-0.3 0.3483 0.3520 0.3557 0.3594 0.3632 0.3669 0.3707 0.3745 0.3783 0.3821

-0.2 0.3859 0.3897 0.3936 0.3974 0.4013 0.4052 0.4090 0.4129 0.4168 0.4207

-0.1 0.4247 0.4286 0.4325 0.4364 0.4404 0.4443 0.4483 0.4522 0.4562 0.4602

-0.0 0.4641 0.4681 0.4721 0.4761 0.4801 0.4840 0.4880 0.4920 0.4960 0.5000

z  0
z

Area
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 B	 Standard Normal Distribution

Numerical entries represent the probability that a standard normal  

random variable is between -∞ and z, where z x
�

�µ
σ

.

z 0.00 0.01 0.02 0.03 0.04 0.05 0.06 0.07 0.08 0.09

0.0 0.5000 0.5040 0.5080 0.5120 0.5160 0.5199 0.5239 0.5279 0.5319 0.5359

0.1 0.5398 0.5438 0.5478 0.5517 0.5557 0.5596 0.5636 0.5675 0.5714 0.5753

0.2 0.5793 0.5832 0.5871 0.5910 0.5948 0.5987 0.6026 0.6064 0.6103 0.6141

0.3 0.6179 0.6217 0.6255 0.6293 0.6331 0.6368 0.6406 0.6443 0.6480 0.6517

0.4 0.6554 0.6591 0.6628 0.6664 0.6700 0.6736 0.6772 0.6808 0.6844 0.6879

0.5 0.6915 0.6950 0.6985 0.7019 0.7054 0.7088 0.7123 0.7157 0.7190 0.7224

0.6 0.7257 0.7291 0.7324 0.7357 0.7389 0.7422 0.7454 0.7486 0.7517 0.7549

0.7 0.7580 0.7611 0.7642 0.7673 0.7704 0.7734 0.7764 0.7794 0.7823 0.7852

0.8 0.7881 0.7910 0.7939 0.7967 0.7995 0.8023 0.8051 0.8078 0.8106 0.8133

0.9 0.8159 0.8186 0.8212 0.8238 0.8264 0.8289 0.8315 0.8340 0.8365 0.8389

1.0 0.8413 0.8438 0.8461 0.8485 0.8508 0.8531 0.8554 0.8577 0.8599 0.8621

1.1 0.8643 0.8665 0.8686 0.8708 0.8729 0.8749 0.8770 0.8790 0.8810 0.8830

1.2 0.8849 0.8869 0.8888 0.8907 0.8925 0.8944 0.8962 0.8980 0.8997 0.9015

1.3 0.9032 0.9049 0.9066 0.9082 0.9099 0.9115 0.9131 0.9147 0.9162 0.9177

1.4 0.9192 0.9207 0.9222 0.9236 0.9251 0.9265 0.9279 0.9292 0.9306 0.9319

1.5 0.9332 0.9345 0.9357 0.9370 0.9382 0.9394 0.9406 0.9418 0.9429 0.9441

1.6 0.9452 0.9463 0.9474 0.9484 0.9495 0.9505 0.9515 0.9525 0.9535 0.9545

1.7 0.9554 0.9564 0.9573 0.9582 0.9591 0.9599 0.9608 0.9616 0.9625 0.9633

1.8 0.9641 0.9649 0.9656 0.9664 0.9671 0.9678 0.9686 0.9693 0.9699 0.9706

1.9 0.9713 0.9719 0.9726 0.9732 0.9738 0.9744 0.9750 0.9756 0.9761 0.9767

2.0 0.9772 0.9778 0.9783 0.9788 0.9793 0.9798 0.9803 0.9808 0.9812 0.9817

2.1 0.9821 0.9826 0.9830 0.9834 0.9838 0.9842 0.9846 0.9850 0.9854 0.9857

2.2 0.9861 0.9864 0.9868 0.9871 0.9875 0.9878 0.9881 0.9884 0.9887 0.9890

2.3 0.9893 0.9896 0.9898 0.9901 0.9904 0.9906 0.9909 0.9911 0.9913 0.9916

2.4 0.9918 0.9920 0.9922 0.9925 0.9927 0.9929 0.9931 0.9932 0.9934 0.9936

2.5 0.9938 0.9940 0.9941 0.9943 0.9945 0.9946 0.9948 0.9949 0.9951 0.9952

2.6 0.9953 0.9955 0.9956 0.9957 0.9959 0.9960 0.9961 0.9962 0.9963 0.9964

2.7 0.9965 0.9966 0.9967 0.9968 0.9969 0.9970 0.9971 0.9972 0.9973 0.9974

2.8 0.9974 0.9975 0.9976 0.9977 0.9977 0.9978 0.9979 0.9979 0.9980 0.9981

2.9 0.9981 0.9982 0.9982 0.9983 0.9984 0.9984 0.9985 0.9985 0.9986 0.9986

3.0 0.9987 0.9987 0.9987 0.9988 0.9988 0.9989 0.9989 0.9989 0.9990 0.9990

3.1 0.9990 0.9991 0.9991 0.9991 0.9992 0.9992 0.9992 0.9992 0.9993 0.9993

3.2 0.9993 0.9993 0.9994 0.9994 0.9994 0.9994 0.9994 0.9995 0.9995 0.9995

3.3 0.9995 0.9995 0.9995 0.9996 0.9996 0.9996 0.9996 0.9996 0.9996 0.9997

3.4 0.9997 0.9997 0.9997 0.9997 0.9997 0.9997 0.9997 0.9997 0.9997 0.9998

z 0
z

Area
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 C	 Critical Values of the Pearson Correlation Coefficient

n a == 0.05 a == 0.01

4 0.950 0.990

5 0.878 0.959

6 0.811 0.917

7 0.754 0.875

8 0.707 0.834

9 0.666 0.798

10 0.632 0.765

11 0.602 0.735

12 0.576 0.708

13 0.553 0.684

14 0.532 0.661

15 0.514 0.641

16 0.497 0.623

17 0.482 0.606

18 0.468 0.590

19 0.456 0.575

20 0.444 0.561

21 0.433 0.549

22 0.423 0.537

23 0.413 0.526

24 0.404 0.515

25 0.396 0.505

26 0.388 0.496

27 0.381 0.487

28 0.374 0.479

29 0.367 0.471

30 0.361 0.463

35 0.334 0.430

40 0.312 0.403

45 0.294 0.380

50 0.279 0.361

55 0.266 0.345

60 0.254 0.330

65 0.244 0.317

70 0.235 0.306

75 0.227 0.296

80 0.220 0.286

85 0.213 0.278

90 0.207 0.270

95 0.202 0.263

100 0.197 0.256

Note: r is statistically significant if r  is greater than or equal to the value given in the table.
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Tax Forms

Form 1040 (2020)

Fo
rm1040 2020U.S. Individual Income Tax Return 

Department of the Treasury—Internal Revenue Service (99)

OMB No. 1545-0074 IRS Use Only—Do not write or staple in this space. 

Filing Status  
Check only 
one box.

Single Married �ling jointly Married �ling separately (MFS) Head of household (HOH) Qualifying widow(er) (QW)

If you checked the MFS box, enter the name of your spouse. If you checked the HOH or QW box, enter the child’s name if the qualifying 
person is a child but not your dependent  �

Your �rst name and middle initial Last name Your social security number 

If joint return, spouse’s �rst name and middle initial Last name Spouse’s social security number

Home address (number and street). If you have a P.O. box, see instructions. Apt. no. 

City, town, or post of�ce. If you have a foreign address, also complete spaces below. State ZIP code

Foreign country name                                        Foreign province/state/county                        Foreign postal code  

Presidential Election Campaign
Check here if you, or your 
spouse if �ling jointly, want $3 
to go to this fund. Checking a 
box below will not change 
your tax or refund. 

You Spouse 

At any time during 2020, did you receive, sell, send, exchange, or otherwise acquire any �nancial interest in any virtual currency? Yes No

Standard 
Deduction

Someone can claim: You as a dependent Your spouse as a dependent

Spouse itemizes on a separate return or you were a dual-status alien

Age/Blindness You: Were born before January 2, 1956 Are blind Spouse: Was born before January 2, 1956 Is blind

Dependents (see instructions):

If more         
than four 
dependents, 
see instructions 
and check 
here �

(2) Social security 
number

(3) Relationship 
to you

(4) ✔ if quali�es for (see instructions):

(1) First name   Last name Child tax credit Credit for other dependents

1 Wages, salaries, tips, etc. Attach Form(s) W-2 . . . . . . . . . . . . . . . . 1
Attach 
Sch. B if 
required.

2a Tax-exempt interest . . . 2a b  Taxable interest  . . . . . 2b 

3a Quali�ed dividends . . . 3a b  Ordinary dividends . . . . . 3b 

4a IRA distributions . . . . 4a b  Taxable amount . . . . . . 4b 

5a Pensions and annuities . . 5a b  Taxable amount . . . . . . 5b

6a Social security bene�ts . . 6a b  Taxable amount . . . . . . 6b 

7 Capital gain or (loss). Attach Schedule D if required. If not required, check here . . . . � 7

8 Other income from Schedule 1, line 9 . . . . . . . . . . . . . . . . . . . 8

9 Add lines 1, 2b, 3b, 4b, 5b, 6b, 7, and 8. This is your total income . . . . . . . . . � 9

10 Adjustments to income:

a From Schedule 1, line 22 . . . . . . . . . . . . . . 10a

b Charitable contributions if you take the standard deduction. See instructions  10b

c Add lines 10a and 10b. These are your total adjustments to income . . . . . . . . � 10c

11 Subtract line 10c from line 9. This is your adjusted gross income . . . . . . . . . � 11

12 Standard deduction or itemized deductions (from Schedule A) . . . . . . . . . .

Standard  
Deduction for—
• Single or 

Married �ling 
separately,  
$12,400

• Married �ling  
jointly or 
Qualifying 
widow(er), 
$24,800

• Head of 
household, 
$18,650

• If you checked 
any box under 
Standard 
Deduction, 
see instructions.

12

13 Quali�ed business income deduction. Attach Form 8995 or Form 8995-A . . . . . . . . 13

14 Add lines 12 and 13 . . . . . . . . . . . . . . . . . . . . . . . . 14
15 Taxable income. Subtract line 14 from line 11. If zero or less, enter -0- . . . . . . . . . 15

For Disclosure, Privacy Act, and Paperwork Reduction Act Notice, see separate instructions. Cat. No. 11320B Form 1040 (2020)
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Form 1040 (2020) Page 2
16 Tax (see instructions). Check if any from Form(s): 1 8814 2 4972 3 . . 16

17 Amount from Schedule 2, line 3 . . . . . . . . . . . . . . . . . . . . 17

18 Add lines 16 and 17 . . . . . . . . . . . . . . . . . . . . . . . .  18

19 Child tax credit or credit for other dependents . . . . . . . . . . . . . . . . 19

20 Amount from Schedule 3, line 7 . . . . . . . . . . . . . . . . . . . . 20

21 Add lines 19 and 20 . . . . . . . . . . . . . . . . . . . . . . . . 21

22 Subtract line 21 from line 18. If zero or less, enter -0- . . . . . . . . . . . . . . 22

23 Other taxes, including self-employment tax, from Schedule 2, line 10 . . . . . . . . . 23

24 Add lines 22 and 23. This is your total tax . . . . . . . . . . . . . . . . � 24

25 Federal income tax withheld from:

a Form(s) W-2 . . . . . . . . . . . . . . . . . . 25a

b Form(s) 1099 . . . . . . . . . . . . . . . . . . 25b

c Other forms (see instructions) . . . . . . . . . . . . . 25c

d Add lines 25a through 25c . . . . . . . . . . . . . . . . . . . . . . 25d

26 2020 estimated tax payments and amount applied from 2019 return . . . . . . . . . . 26

27 Earned income credit (EIC) . . . . . . . . . . . . . .
• If you have a 

qualifying child, 
attach Sch. EIC.

• If you have 
nontaxable 
combat pay, 
see instructions.

27

28 Additional child tax credit. Attach Schedule 8812 . . . . . . . 28

29 American opportunity credit from Form 8863, line 8 . . . . . . . 29

30 Recovery rebate credit. See instructions . . . . . . . . . . 30

31 Amount from Schedule 3, line 13 . . . . . . . . . . . . 31

32 Add lines 27 through 31. These are your total other payments and refundable credits . . . �   32
33 Add lines 25d, 26, and 32. These are your total payments . . . . . . . . . . . � 33

Refund 34 If line 33 is more than line 24, subtract line 24 from line 33. This is the amount you overpaid . . 34

35a Amount of line 34 you want refunded to you. If Form 8888 is attached, check here . . . � 35a
Direct deposit?  
See instructions.

� b Routing number � c Type: Checking Savings
� d Account number
36 Amount of line 34 you want applied to your 2021 estimated tax . . � 36

Amount  
You Owe
For details on 
how to pay, see 
instructions.

37 Subtract line 33 from line 24. This is the amount you owe now . . . . . . . . . .  � 37

Note: Schedule H and Schedule SE �lers, line 37 may not represent all of the taxes you owe for 
2020. See Schedule 3, line 12e, and its instructions for details. 

38 Estimated tax penalty (see instructions) . . . . . . . . . � 38

Third Party 
Designee 

Do you want to allow another person to discuss this return with the IRS? See 
instructions . . . . . . . . . . . . . . . . . . . .  � Yes. Complete below. No
Designee’s 
name  �

Phone 
no.  �

Personal identi�cation 
number (PIN)  �

Sign  
Here 

Joint return?  
See instructions.  
Keep a copy for 
your records. 

Under penalties of perjury, I declare that I have examined this return and accompanying schedules and statements, and to the best of my knowledge and 
belief, they are true, correct, and complete. Declaration of preparer (other than taxpayer) is based on all information of which preparer has any knowledge.

Your signature Date Your occupation If the IRS sent you an Identity 
Protection PIN, enter it here 
(see inst.) �

Spouse’s signature. If a joint return, both must sign. Date Spouse’s occupation If the IRS sent your spouse an 
Identity Protection PIN, enter it here 
(see inst.) �

Phone no. Email address 

�

Paid  
Preparer  
Use Only 

Preparer’s name Preparer’s signature Date  PTIN Check if:

Self-employed

Firm’s name  � Phone no. 

Firm’s address  � Firm’s EIN  �

Go to www.irs.gov/Form1040 for instructions and the latest information. Form 1040 (2020) 
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Schedule 1 (Form 1040)
SCHEDULE 1 
(Form 1040)

Department of the Treasury  
Internal Revenue Service  

Additional Income and Adjustments to Income
�  Attach to Form 1040, 1040-SR, or 1040-NR.�

 �  Go to www.irs.gov/Form1040 for instructions and the latest information.

OMB No. 1545-0074

2020
Attachment   
Sequence No. 01 

Name(s) shown on Form 1040, 1040-SR, or 1040-NR Your social security number

Part I Additional Income

1 Taxable refunds, credits, or offsets of state and local income taxes . . . . . . . 1

2a Alimony received . . . . . . . . . . . . . . . . . . . . . . . . . . . 2a

b Date of original divorce or separation agreement (see instructions) �

3 Business income or (loss). Attach Schedule C . . . . . . . . . . . . . . . 3

4 Other gains or (losses). Attach Form 4797 . . . . . . . . . . . . . . . . . 4

5 Rental real estate, royalties, partnerships, S corporations, trusts, etc. Attach Schedule E 5

6 Farm income or (loss). Attach Schedule F . . . . . . . . . . . . . . . . . 6

7 Unemployment compensation . . . . . . . . . . . . . . . . . . . . . . 7

8 Other income. List type and amount �
8

9 
 

Combine lines 1 through 8. Enter here and on Form 1040, 1040-SR, or 1040-NR, 
line 8 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

Part II Adjustments to Income

10 Educator expenses . . . . . . . . . . . . . . . . . . . . . . . . . . 10

11 
 

Certain business expenses of reservists, performing artists, and fee-basis government 
of�cials. Attach Form 2106 . . . . . . . . . . . . . . . . . . . . . . . 11

12 Health savings account deduction. Attach Form 8889 . . . . . . . . . . . . 12

13 Moving expenses for members of the Armed Forces. Attach Form 3903 . . . . . 13

14 Deductible part of self-employment tax. Attach Schedule SE . . . . . . . . . 14

15 Self-employed SEP, SIMPLE, and quali�ed plans . . . . . . . . . . . . . . 15

16 Self-employed health insurance deduction . . . . . . . . . . . . . . . . . 16

17 Penalty on early withdrawal of savings . . . . . . . . . . . . . . . . . . 17

18a Alimony paid . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18a

b Recipient’s SSN . . . . . . . . . . . . . . . . . . . . �

c Date of original divorce or separation agreement (see instructions) �

19 IRA deduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19

20 Student loan interest deduction . . . . . . . . . . . . . . . . . . . . . 20

21 Tuition and fees deduction. Attach Form 8917 . . . . . . . . . . . . . . . 21

22 
 

Add lines 10 through 21. These are your adjustments to income. Enter here and 
on Form 1040, 1040-SR, or 1040-NR, line 10a . . . . . . . . . . . . . . . 22

For Paperwork Reduction Act Notice, see your tax return instructions. Cat. No. 71479F Schedule 1 (Form 1040) 2020
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Getting Started with Microsoft Excel (Desktop)

The Basics of Microsoft Office Excel 365
Microsoft Excel is a spreadsheet program that allows users to track and analyze data. Spreadsheets such as those created 
with Microsoft Excel are widely used in the business world to perform various tasks such as accounting, budgeting, billing, 
reporting, planning, and tracking. The instructions provided in this Appendix are intended for non-mobile users.

When you open Excel, you will see various tabs along the top such as File, Home, Insert, Page Layout, Formulas, Data, etc. 
The numerous commands and options available when working within Excel can be found under these tabs. At the bottom, 
there is a tab labeled Sheet1. The icon to the right of the Sheet1 tab creates a new tab with a blank spreadsheet. Tabs can be 
renamed by double-clicking on them and entering new text. Figure C.1 shows what a new workbook looks like when Excel 
is first opened.

Figure C.1

Cells

Cells in Microsoft Excel may contain numerical data and/or text. The cells’ locations are described by their positions in terms 
of columns and rows. Columns are listed from left to right across the top of the worksheet and are labeled with letters. Rows 
are listed from top to bottom along the left side of the worksheet and are labeled with numbers. A column letter followed by 
a row number describes the active cell position. For example, B2 would be referring to the cell found in the second row of 
Column B (see Figure C.2). A thick solid border will outline the active cell. To help you identify the cell address, the column 
and row headers are also highlighted. Another way to identify the active cell’s address is to look at the window just above the 
header for Column A.

Figure C.2©HAWKES LEARNING
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The column width can be altered by placing your cursor between two column labels; when it turns into a vertical line with 
arrows pointing to the left and right, you can then click and drag to the left or right to make the column width larger or 
smaller. The same can be done with row heights. Alternatively, double-clicking between two column or row labels will autofit 
the row height or column width to the data it contains.

To change the active cell, move the mouse to the desired cell and click. The border will now be surrounding the new cell and 
the address will have changed in the active cell address window. The arrow keys can also control navigation of the active cell.

To the right of the cell address window is the formula window (labeled with fx). This displays the contents of the active cell. 
The contents of the cell can be edited either within the formula window or the cell itself. Thus, as you enter data in the active 
cell, it is displayed within the cell and in the formula window at the top of the worksheet.

Suppose you wanted to sum the numbers 15, 10, and 3. To do this, enter the formula =15+10+3 into cell A1. The equal sign, 
“=”, is the command to start a formula in Excel. Notice that the formula is seen within in the cell as well as in the formula 
window (see Figure C.3a). When you press Enter, you will see that the active cell moves to cell A2, and the solution of 28 is 
now displayed in cell A1 (see Figure C.3b).

Figure C.3a Figure C.3b

When you finish entering a formula in a cell, press Enter. The active cell will now move one row down. The answer to 
the formula, rather than the formula itself, will be displayed in the cell. Cells or data can be added, subtracted, multiplied, 
divided, and manipulated in any combination through formulas.

Filling Cells

Excel will try to anticipate a reoccurring word or phrase within a column. After you have entered some text in a column, 
if you type the first letter of a previous cell again, Excel will fill in the rest of the word or phrase. To accept the automatic 
completion of the word, just hit the Enter key or click in a new cell. If you do not want to use the automatic completion of 
the word, simply keep typing in the cell and the new word or phrase will appear. Under the Review tab, there is an option for 
Excel to spell check your spreadsheet.

Figure C.4
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Excel has a helpful tool when entering a series of data. Try entering 1 into cell A1 and 2 into cell A2. Then highlight both of 
the cells. You will see a small square at the bottom right of the highlighted section.

Figure C.5

If you move your cursor over this square, the cursor should change into a narrow plus sign. Now, click the left mouse button 
and drag the mouse down to include cells A3 through A10. When you release the mouse button, the cells should now be 
filled with values from 1 to 10. We will refer to this as filling cells. Also notice that at the bottom of the screen, Excel gives 
some summary statistics about the highlighted cells. The average, count of the number of values, and sum are displayed for 
any highlighted cells.

Figure C.6

The fill tool will work for other (nonsequential) values as well. Excel finds the relationship between two data points and 
replicates this when the tool is used. As an example, try this with multiples of 5. Enter 5 in cell A1 and 10 in cell A2. Highlight 
cells A1 and A2 again and put your cursor over the square in the bottom right of the highlighted section. Click the left mouse 
button and drag down to cell A10. Release the button. Now the values should have changed to 5 through 50, in increments 
of 5.
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Figure C.7

You can also use this feature with sequential labels such as days of the week or months of the year. For example, if you type 
Monday into cell A1 and use the fill tool to drag to cell G1, the intermediate cells will populate with all of the days of the week.

Figure C.8

Under the Home tab, you can change the appearance of text by altering the font, size, color, or alignment of the text within 
the cells. You also can use Microsoft Excel to sort a long list of items alphabetically or numerically or to find a particular item 
you are looking for. The sort and find features can be found under the Home tab as well.

Now that you have the basic skills to work with Excel, start a new worksheet and we will try some examples.

Formulas and Addressing Using Excel

Enter the labels Checking Balance and Savings Balance in cells A1 and B1, respectively. You will notice that the label you 
typed in cell A1 is cut off. We need to resize the columns to allow for the entire label. Move your cursor to the line that 
separates the column labels for A and B. Your cursor will change to an arrow pointing off to the left and right. You can click 
and drag the cursor to the right to increase the column width, or simply double-click to have the width autofit the label. 
Repeat this for Column B.

Next, select the column labels A and B and you should see both columns highlighted. Under the Home tab there is an 
area labeled Number. The buttons in this area format any numbers you enter in the selected cells. With columns A and B 
highlighted, click on the $ button. Now all of the values put in these columns will be formatted as currency.
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Next, we will use the fill tool to get some values to work with. Start by entering 100 in cell A2 and 200 in cell A3. 
Now move to cell B2, enter 1000, and enter 2000 in cell B3. Highlight cells A2 through B3 by clicking in A2 and 
dragging down and to the right to include B3. With those cells highlighted, put your cursor over the square in the 
bottom right of the highlighted section. When your mouse changes to a narrow plus sign, click and drag down to 
row 11. When you release the mouse button, the cells should fill with data and end with $10,000.00 in cell B11. You 
should have a screen that looks like the following.

Figure C.9

Formulas can be applied to manipulate data between cells. We will see, however, that special attention needs to be paid 
to the copying of formulas. We will continue working with the above worksheet with the checking and savings balances 
while we try some formulas.

We want to see what your total bank balance would be if you had the amount listed in a particular row in your 
checking and savings accounts. In cell C2, type = to indicate you are entering a formula, and then click in cell A2, 
type +, and click in cell B2. Press Enter. You have just added cells A2 and B2 together, and the sum ($1,100.00) is 
displayed in cell C2. Under the Home tab, the Clipboard section contains buttons allowing you to cut, copy, and 
paste cells. With cell C2 selected, either click on the copy button or use the keyboard shortcut Ctrl+c to copy the 
formula. Highlight cells C3 through C11. Under the Home tab, press the Paste button or use the keyboard shortcut 
Ctrl+v to paste the formula into these cells. Notice that the value $1,100.00 that was displayed in C2 was not copied, 
but the formula that made up that value. The formula changed for each of the rows and substituted the new row 
value in the formula. This is called relative addressing. The formula changes relative to its cell address. The last cell 
should show the value $11,000.00. If the value is not visible, the column needs to be resized.

Suppose we wanted to see what the annual interest would be on our savings account at the levels listed in Column B. 
Create a new label in cell A13 called Interest Rate. Now in cell B13, input the interest rate 0.045. We will need to 
format the cell for percentages rather than currency. To do this, highlight cell B13, and under the Home tab in the 
Number area, select the % button next to the $ button that we used to originally format the cells. The number will 
most likely be displayed as 5%. We can adjust the number of decimals displayed by clicking on the  button, also 
located in the Number section under the Home tab. This button increases the number of decimal places displayed 
by one decimal place each time it is clicked. (Notice that there is a similar button next to the one mentioned that 
decreases the number of places displayed.) The value should now display as 4.5%.

Now we want to use this value to compute interest for each level of savings. Label cell D1 Savings Interest. Resize the 
cell to fit the label. In cell D2, we will put our formula. Type = to start the formula, and then select cell B13 to get the 
percentage rate. Type * to indicate multiplication, and select cell B2. Upon pressing Enter, the resulting value will 
be displayed ($45.00). Thus, the annual interest gained on $1,000.00 in savings at 4.5% APR is $45.00.
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Since we have the formula, we can copy it to the rest of the column and get the interest income for each of the savings levels. 
With cell D2 selected, click in the lower right-hand corner of the cell and drag down to D3. Is this the result you expected? 
Probably not. Remember the rules of relative addressing. As you copy the formula down one row, the formula values change 
by one row. So in cell D3, the formula is pulling from cell B14 for the interest rate and cell B3 for the principal amount. You 
will notice that cell B14 is empty. Thus, Excel computes this formula as being equal to zero. However, want to use cell B13 for 
each of these formulas in Column D. So how do we lock in the address of cell B13? We use absolute addressing. The $ symbol 
is the key to locking the position in the formula. If the $ is in front of the column indicator of a cell reference, it will lock the 
column ($B13), and if it is in front of the row indicator, it will lock the row (B$13). These can be used together to lock a cell 
reference to a specific cell. In cell D2, we need to change the formula to read =$B$13*B2. This will “lock” cell B13 into the 
formula when it is copied throughout Column D.

Go back and copy the new formula into cells D3 through D11 using the fill tool. The results should now look like Figure C.10.

Figure C.10

Excel can compute a multitude of calculations on data values in the spreadsheet. If you press the fx button next to the formula 
window, you can explore all of the functions and formulas that Excel has to offer.

Charts

Suppose you have the following data about ticket sales from your county fair. Adult tickets are $20 and child tickets are $12. 
Ticket sales for the week are listed in Figure C.11.

Figure C.11

From these data, you might see how the ticket sales change daily and wish to compare child and adult ticket sales. This 
information might be easier to understand if it were graphically displayed on a chart. Enter the data as seen above in a new 
worksheet and use a bar chart for this particular example.
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To create a chart, we need to select the data to be graphed. We want to chart the ticket sales for both the adults and children. 
In a bar chart, the dollar amount will determine the height of the bar. The days of the week should also be included since they 
are the labels for the bars.

Highlight the data in Columns A, B, and C from rows 1 to 8. (Note that Excel can interpret the first row or column in a set of 
data as labels and not part of the data.) Under the Insert tab, there is a Charts group of icons.

Figure C.12

Choose Column (in the upper left corner), and then select the top-left graph (the first one listed under the 2-D column 
heading). This is a clustered column graph. Excel creates a side-by-side bar graph based on the highlighted data. After the 
chart is created, a set of tabs labeled Chart Design and Format appear. Additionally, three icons appear to the right of the 
chart: Chart Elements, Chart Styles, and Chart Filters. These tabs and icons can be used to edit the chart that has been made.

Click on the chart title, type a new title of “Ticket Sales”, and press Enter. Using the Chart Elements icon, you can edit the 
chart appearance by adding axis titles, data labels, or gridlines. Microsoft Excel makes it easy to create the chart you want.

Figure C.13

Excel can create most types of charts, ranging from pie charts to line graphs to scatter plots. These types of charts are indicated 
by the menus seen when an icon in the Charts group is clicked on. 
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